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Precautions for use 
Please be sure to read and follow the instructions below for safe use. 

 

Intended use: BB-E7 is intended for CNC engraving 
 

 The instructions below are intended to prevent personal injury and property damages. 

 Please read carefully and use the machine properly. 

 
If you do not follow these instructions, injury or property damage may occur. 

 
If you do not follow these instructions, users may be seriously injured. 

 

 Precautions related to power 

 

Do not use damaged cord or loosened 
outlet. 
 It may cause electric shock or fire.  

Do not put multiple power plugs into one 
inlet simultaneously. It may cause fire due to 
overheated inlet. 

 

Do not pull a plug by the cord. Do not 
touch a power plug with wet hands.  

When the machine is not in use for a long 
period of time, pull out the power plug. 

 

If smoke comes out from the machine 
during use, turn off the machine 
immediately and call the dealer or our 
service center. 

 

Plug-in the provided power cable only to the 
grounded outlet (power mains). 
If the outlet (power mains) is not ground-
wired, set the grounding separately. 

 Precautions related to use 

 

We will not be held responsible for damage 
caused to machine by misuse or poor care.  

Performance and quality of marking and 
cutting may vary depending on materials. 

 

Be sure to use a safety cover to prevent 
the particle.  
Dispersed chips and metal dust can 
cause serious injury  
to the eyes and can cause respiratory 
problems when inhaled. 

 

Be sure not to get caught or jammed 
between the paths of each axis of the 
machine, or scratched by the engraving 
cutter. 
 It may cause serious injury, or damage 

or failure of the machine. 

 

Be sure to use a chip collector to 
remove the particle. Dispersed chips and 
metal dust can cause serious injury to the 
eyes and can cause respiratory problems 
when inhaled. 

 

Do not put a candle or cigarette button the 
machine. Avoid any heating apparatus like 
heater when using this machine. 
 It may cause failure or fire due to 

overheating. 

 

Be sure to place the machine body only on 
a stable level surface.  

Be sure to keep out of the reach of 
toddlers and children. Their curiosity or 
carelessness may cause injury. 

 

Do not disassemble or modify the machine.  
 It may cause fire, electric shock or 

failure. Please contact the dealer or 
our service center for inspection, 
calibration and repair. 

 

Do not put water or small metal materials on 
the machine.  
 Due to negligence or vibration of the 

machine, the materials may fall and 
cause injury, fire or failure by 
overheating or short circuiting. 

 If water gets into the machine, it may 
cause electric shock or fire. 
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 Precautions related to use 

 

Do not allow any body parts or other 
objects onto the machine. 
 The cutter of machine may cause 

serious injury during its operation. 

 

 

Please wear the safety glasses for safe.  
 The cutter of machine may cause 

serious injury during its operation. 

 

 

Do not put water or small metal materials 
on the machine.  
 Due to negligence or vibration of the 

machine, the materials may fall and 
cause injury, fire or failure by 
overheating or short-circuiting. 

 If water gets into the product, it may 
cause electric shock or fire. 

 

Do not use this machine in a place with oil, 
smoke, moisture, dust or water.  

It may cause electric shock or fire. 

 

Based on it's product specification, there is 
some lubricant oil that comes out from the 
machine. It is a usual occurrence. 

  

 Other Precautions 

 

Do not disassemble or modify the 
machine.  
 It may cause fire, electric shock or 

failure. Please contact the dealer or 
our service center for Inspection, 
calibration and repair. 

 

When temperature falls below freezing, 
the product may not work property. In this 
case, please maintain the room 
temperature in the place where you use 
this machine for normal operation. Please 
make sure the temperature in the place 
where you use the machine does not fall 
below freezing. 

 

<WASTE SEPARATION> 
This machine must be disposed of in special waste containers. 
The following instructions are intended exclusively for cases where the equipment is used in 
European countries: 
●This machine must be disposed of in special waste containers. Do not dispose of with household 
waste. 
●For further information, please contact the local authorities responsible for waste disposal. 
 

 
Laser specifications 
 

This machine uses the red laser ‘CLASS 2’ as a guide laser. 
 
- CLASS 2: A Class 2 laser is relatively weak. It normally would not harm an eye unless a person deliberately 

stared into the beam. Laser protective eyewear is normally not necessary. A Class 2 laser is not a 
skin or materials burn hazard. However, even a Class 2 laser can be a distraction, glare or flash 
blindness hazard for pilots and drivers. NEVER aim any laser towards an aircraft or vehicle that is in 
motion.  

 

Class Class 2 

Output <1mW 

Wavelength 650nm 
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Model 
 

Model BB-S4 BB-E4 BB-S7 BB-E7 

Engraving 
area 

213*161 216*158 112*100 112*100 

Rotary 
Clamp ✖ ✖ ● ● 

Spindle ✖ ● ✖ ● 

DC Motor - 38w - 38w 

Spindle 
RPM 

- 15,000 - 15,000 

Probe 
Sensor ✖ ● ✖ ● 

※ The difference between the models is whether use specific features or not. And main model is BB-E7. 
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BB-E7 
1. Contents of the box 
The BB-E7 provides the following accessories. Their composition may differ depending on the options.  

NOTICE)  

• Cutter, tip and spindle belts are consumables. Make sure to replace them with the new one on a regular 

maintenance schedule. 

•There may be parts not homologous with the manual. 

•Be sure to use a safety cover to prevent the particle.  
 

Name Picture Quantity Usage 

BB-E7 

 

1EA 

Engraving machine 

※Be sure to use a safety cover to 

prevent the particle. 

Power adapter 

 

1EA 

Power supply 

※Use the power cable connected to the 

grounded outlet. Unless the outlet is 

grounded, separately ground the 

machine. 

USB Cable 

 

1EA PC connection 

Program installation USB  1EA 
Design & marking software installation 

USB 

User manual 
 

1EA Operating manual 

L-wrench 

(1.5mm)  1EA Tool for tightening/replacement of bolt. 

T-wrench 

(2mm) 
 

1EA Tool for tightening/replacement of bolt. 

L-wrench 

(2.5mm)  1EA Tool for tightening/replacement of bolt. 

L-wrench 

(3mm)  
1EA Tool for tightening/replacement of bolt. 

Ruler  1EA  

Tool fixing bolt 

(M4x5)  3EA Spindle tool fixing bolt 

L-tool fixing bolt 

(M3x4)  3EA L-tool tip fixing bolt 

Diamond tip 

(4Ø )  1EA 
Tool for engraving of material or ring 

outer diameter. (For spindle) 

Diamond tip 

(3Ø )  1EA 
Tool for ring engraving of ring inner 

diameter. (For L-tool) 
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Endmill cutter 

(4Ø  0.6)  2EA Tool for cutting. (For spindle) 

Spindle belt 

(5Ø /50mm) 
 

3EA 
Silicon belt for transferring DC motor’s 

rotation power to spindle. 

Tool holder 

 

1EA Storage for tools. 

Back port cover 
 

1EA 
For protecting the port cover from 

scratches. 

Bakelite plate 

(120x100x2t) 
 

1EA For calibrating the camera 

Multi-

performance 

Clamp Set 

Multi-

performance 

clamp 

 

1EA 
For holding a variety of shape of 

materials in place. 

Pin for 

clamp  6EA For holding of irregular shaped material. 

Bolt 

(M4x20mm)  4EA 
Bolt for tightening the clamp after 

remove the clamp spacer block 

Rotary 

Clamp 

Set 

Chuck 

Handle  2EA Rotary clamp-tightening handle 

Flat chuck 

finger  
3EA 

For holding rings when marking thin 

ring’s inner/outer diameter 

Round 
chuck finger 
(Wide width)  

3EA 

For holding rings when engraving on 

ring outer diameter of rings or ring inner 

diameter of flat rings. 

Finger Skin 
 

1SET For protecting chuck fingers 

Rotary Clamp 

 

1EA 

For holding ring materials in place. 

* 4mm chuck finger is included. 

* Basic installation equipment of 

machine. 

Finger 

Spanner  
1EA Tool for tightening chuck fingers. 

 

*Optional (Purchased separately) 

Chip collector 

 

1EA 

-Dry type: The dry type sucks in chips 

and dust generated from engraving 

acryl, modeling board, etc.   

-Wet type: The wet type is a combined 

suction device embedded in the cutting 

oil pump, which sucks in and 

discharges cutting oil simultaneously 

with metal cutting to enhance the 

convenience of cutting. 
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Front cover 

set 

Front cover 

 

1EA Safety cover to prevent the particle 

Bolt 

(M4x12)  
2EA Front cover fixing bolt 

Washer 

(M4) 
 

2EA Used with front cover bolt 

Spring 

washer 

(M4)  

4EA Used with front cover bolt 

Spacer 

 

2EA Front cover spacer 

Bolt 

(M4x6)  
2EA Cover stopper fixing bolt 

Cover 

stopper 

 

2EA Front cover stopper 

Tailstock 

set 

Tailstock 

 

1EA Clamp for engraving pen and etc. 

Pen adapter 

 

1EA Part of tailstock 

Tailstock 

fixing bolt  
1EA Bolt for tightening the tailstock. 

Pin 

(6Ø x25mm)  2EA Pin for fixing the tailstock. 

Rotary 

clamp 

Round chuck 
finger 

(Narrow 

width) 
 

3EA 
Finger for holding rings when engraving 

ring inner diameter of rings. 

Cutting 
clamp 

set 

Cutting 
clamp 

 

1EA 

Clamp to help cut a board while it is 

pressed down, fixed, and soaked in 

cutting oil. (PU Sheet included) 

Cutting nose 
(4Ø ) 

 

1EA 

Part to mount on the head to protect 

tool and cut in a certain depth on 

materials. 

Pincette 

 

1EA 
Takes out the cut plate easily by using 

this pincette without dirtying the hands. 
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Scraper 
 

1EA 
Scraps the chips easily by using this 

rubber scraper 

Cutting 
clamp cover 

 

1EA Cutting clamp protect cover 

L-wrench 

(5mm)  
1EA 

Tool for tightening/replacement of bolt. 

(For E4) 

Paper filter  

 

10EA Filter for metal chips  

Ring 
engraving 

adapter 
set 

Ring 
engraving 
adapter  

1EA 

Part to more firmly fix a ring to engrave 

using a pen clamp when engraving on 

the outer diameter of a ring 

Collet for 
rings 

 

1SET 

9 types of collets are provided for 

different ring sizes and they are 

expendable. 

Height adjustable clamp 

 

1EA Clamp to adjust the clamp height 

Bracelet adapter 

 

1SET Jig to easily fix a bracelet for engraving 

Cutlery clamp 

 

1SET Jig to easily fix a spoon for engraving 
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2. Specifications 
 

 

Operating voltage AC 100~240V 

Power consumption 58W 

Frequency 50/60Hz 

Dimensions 
402.5 mm(W) x 376.5 mm(D) x 352.2 mm(H)  

15.85 in(W) x 14.82 in(D) x 13.87 in(H) 

Max.engraving area 
112mm(X) x 100mm(Y) x 38.5mm(Z) 

5.5 in(X) x 3.9 in(Y) x 1.5 in(Z) 

Maximum material height 60mm/ 2.4 in 

Rotary operating range 

(Based on 2mm/ 0.08in) 

Cylinder outside diameter: MAX. 92mm (X) / MAX. 3.6in (X) 

Cylinder inside diameter: MAX. 14mm (X) / MAX. 0.6in (X) 

Resolution 0.0025mm (X,Y), 0.000625mm (Z), 0.028125° (A) 

Weight 26kg 

RPM 9,000~15,000 RPM 

Spindle motor power 38W 

Transfer speed 80mm/sec (X,Y), 18mm/sec (Z) 

Bluetooth Bluetooth LE module/ Bluetooth 5.0 

Temperature 15 – 40°C 

Humidity 10 - 90 % 

Purposes 
Metal marking, cutting, Pen marking, Ring inner diameter marking, 

Ring outer diameter marking, etc. 
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3. Descriptions 
(1) Machine 
 

 

                           

             
 

 

 

 

 
  

J. Status Indicator 

M. USB Port 

N. Power Port 

O. IO Port 

F. Control Panel 

K. Emergency Switch 

L. Power Switch 

H. Spindle 

C. L-Tool 

B. Pressure Adjuster 

A. Pressure Lock 

D. L-Tool Fixing Bolt 

Spindle 

Tool 

Do not put your hand or  
body part inside the machine  

as the head moves. 

I. Probe 

G. Camera 

E. Tool Length Sensor 
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A Pressure Lock Set the pressure lock. 

B Pressure Adjuster Adjusts the pressing of the engraving tool. 

C L-Tool 
Fixes the tip used when engraving the ring inner diameter of 

rings or bangles. (Tool change: 1.5mm L-wrench) 

D L-Tool Fixing Bolt Fixes or adjusts the L-tool. 

E Tool Length Sensor Automatic tool length measurement sensor. 

F Control Panel Controls the power button and marking machine. 

G Camera Directly showing a material to design. 

H Spindle Fixes the engraving tool. (Tool change: 2mm T-wrench) 

I Probe Measures the height of engraving material. 

J Status Indicator 
The device status can be checked through the blinking interval 

of the status indicator. 

K Emergency Switch Emergency stop switch. 

L Power Switch Turn on/off the power switch. 

M USB Port Connects the USB cable plugged into the cable. 

N Power Port 

Connects the power adapter and supplies power to the marking 

machine. 

※ Use the power cable connected to the grounded outlet. 

Unless the outlet is grounded, separately ground the 

machine. 

O IO Port 

It controls the external devices.  

You can control the power on/off of the chip collector by 

connection to the IO port. 
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(2) Clamp 
 

1) Multi-Purpose clamp 
Since the holding part of clamp is step type, fix set the clamp to the step that matches the size and thickness.  

 

 
 

 

 

 
Basic components packaged with BB-E7 include a multipurpose clamp designed in 3-tier buildup structure where 
the bottom-level base part, middle part, and the multipurpose part at the top are available respectively to fix a 
material. Users can select an appropriate tier for the height and form of their material. This component efficiently 
minimizes additionally required optional clamps according to the shape and size of materials.  

 
 

[How to fix the material on the clamp] 
If you turn the clamp fastening knob to the counterclockwise, then the clamp will be widen the gap. And turn it to 

the clockwise, then the clamp will be tightened. 

 

          
 

When holding the materials by turning the clamp fastening knob, a mark may be left on the 

materials. 

  

Pin holes 

Clamp fastening knob 

Spacer block 

Clamp slider 

Clamp base 

Clamp fixing knob 
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[How to use the gradation on the clamp] 
Gradation on the clamp also helps easier positioning of material on the clamp. 
 

 
 

[How to use the pin] 
Fix the pin (3Ø ) on the clamp. Pin holes on the clamp ensures easier holding of irregular shaped material. 

 
 

 
 
[How to adjust the height of the clamp] 
he height of the clamp can be adjusted depending on the thickness of the materials or the type of clamps. 
 

Name Picture Quantity Usage 

M4x20mm  4EA 
Bolt for tightening the clamp after 

remove the clamp spacer block 

L-wrench 

(3mm)  
1EA 

Tool for tightening/replacement of 

bolt. 

 
1. Turn the clamp fixing knob to pull out the clamp. 
 

         

Clamp base 
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2. Turn the clamp upside down, and remove the clamp fixing bolt (M4x40mm) by using 3mm L-wrench. 
 

         
     <Clamp back side>  
3. After remove the clamp fixing bolt (M4x40mm), turn the clamp and pull out the [Clamp base].  

 

             
 
4. Remove the spacer block fixing bolt (M4x20mm) by using 3mm L-wrench.  
 

                 
 
5. Pull out the spacer block. 
 
 

     
             <Spacer block>                         <The first tier of clamp> 
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6. Fix the [Clamp base] on the pin.  
 

                       
 
7. Turn the clamp upside down, and fix the bolt (M4x20mm) by using 3mm L-wrench. 
 

                    

 
<The first tier of clamp base> 

 
8. When assembling the spacer block again, be aware of the type of bolts below the order. 

 

                                        
<Spacer block fixing bolt- M4x20mm>         <Clamp base fixing bolt- M4x40mm>          
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[Height adjustable clamp]  
-Optional (Purchased separately) 

 
 
The height of the clamp can be adjusted by using height adjustable clamp depending on the thickness of the 
materials or the type of clamps. 
 
1. Turn the clamp fixing knob to pull out the clamp. 

            
 
2. Set the clamp as the first tier of clamp base which the spacer block is removed. 

 
<The first tier of clamp base> 

 
3. Insert the height adjustable clamp in the direction of the arrow. And turn the clamp fixing bolt to fix it.  

         
 
4. Insert the first tier of clamp base and fix it by turning clamp fixing bolt on height adjustable clamp. 
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2) Rotary clamp 
- Basic installation equipment of machine. 

     

Press the rotary clamp button to enter the ring outer/inner diameter mode. 

                

                
 

[Holding method for engraving ring outer diameter of rings] 
Insert the ring until it clicks onto the flat chuck finger and turn the chuck handle to hold the ring and not to allow it 
to fall off or spin. 

                   
 

[Holding method for engraving of ring inner diameter of rings] 
Open the chuck finger of the rotation clamp and insert the ring, and use the chuck handle to hold it not to allow it 
to fall off or slip. 

                   
 
[Chuck finger replacement method] 

 
There are three types of chuck fingers. According to the shape of the ring, use chuck finger appropriately 
to hold the ring and not allow it to become loose or fall off. 
 

                 
Flat chuck finger          Round chuck finger (wide width)   Round chuck finger (narrow width 

                                                                           -Purchased separately) 
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Use the chuck finger spanner provided along with the product to release or tighten the chuck finger. 
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3) Tailstock 
-Optional (Purchased separately) 

 
 
-Height from bottom to central axis: 69mm 
-Lateral travel distance of pen clamp: 109.5mm 
 
Tailstock and pen adapter is a part that firmly fixes a long cylindrical material such as pen, tumbler, and wine 
glasses in order not to let it tilt to one side. Fix easily various cylinder-formed materials using a tailstock and pen 
adapter. Mark on cylindrical materials such as tumbler, mugs, wineglasses, and drinking glasses. 

 
 

[How to set the tailstock] 
 

Tailstock fixing bolt 
 

Pin (6Ø *25mm)  

 
1. Set the tailstock with pin. 

        
 
2. Fix the tailstock with tailstock fixing bolt. 

         
 

Pen adapter 

Tailstock slide fixing bolt 

Pen adapter fixing bolt 



20 

3. Place the pen in the flat chuck finger of the rotary clamp, and slid the tailstock until it touches the pen fixed in 
the chuck finger.  

          
 
4. Tighten the tailstock slide fixing bolt so that the tailstock is not pushed, and tighten the pen adapter fixing bolt to 
securely fix the pen. 

              
 

  

[Ring engraving adapter]  
-Optional (Purchased separately) 
 

 
 
Part to more firmly fix a ring to engrave using a pen clamp when engraving on the outer diameter of a ring 
 

1. Turn the fixing nut counterclockwise to detach the ring adaptor.  

 
2. Fix a ring on the collet to the correct size. 

  
*Collet for rings: 9 types of collets are provided for different ring sizes and they are expendable.  

 
3. Put the collet onto the ring adaptor and turn the fixing nut clockwise to tighten.  
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4. Loosen the chuck finger and set the ring engraving adaptor fixed with the ring.    
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4) Cutting clamp 
-Optional (Purchased separately) 
 

 
1. Open the clamp as wide as possible, and put the cutting clamp, then tighten it. 

        
 
2. Release fixing knob on the cutting clamp.  

 
3. Put materials on the spacer plate and fix it by using fixing bar.  

      
 
4. Hold and slide the end of the fixing bar while turning the fixing knob to secure it. 

    
* Be sure that the fixing bar fixing part secures the 
material enough. 

  

Fixing knob 

Fixing bar 

Felt filter 

PU Sheet (110x100x1t) 
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(3) Keypad 
 

 

  

Display Status display 

Operation Buttons 
Depending on the situation, it performs the function indicated on the 

display. 

 

 

Direction 

Key 

(X,Y/Z/A) 

• Moves marking area. 

• Direction:  (X) Moves X axis 

 (Y)(Z)(A) Moves Y/Z/A axis(Mode change by using operation 

buttons.) 

 

Vacuum 

ON/OFF 

Vacuum chip collector power button. 
 

• Automatic control: Starts automatically when engraving and stops 

automatically after engraving is completed.  
 

• Manual operation: When the user manually turns on the chip collector, 

automatic control is deactivated. When the engraving is finished, the user 

must stop it. 

 

Be sure to use a chip collector to remove the particle. 

Dispersed chips and metal dust can cause serious injury to 

the eyes and can cause respiratory problems when inhaled. 

 
Start 

Starts marking when pressed for a long time (2 seconds or longer). 

• Repeat marking: Press and hold the  button to finish marking, then 

double-click the  button to mark repeatedly when marking the same 

work.  

• Menu: OK 

 
Menu Enter the menu mode. 

 
Stop Stops marking 

  

Display 

Operation  

Buttons 
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(4) Menu 

Press on the keypad and get into the [MENU] mode. Select a menu using the  and  buttons and 

press  button.  

1. Tool Change Changes the tool 

2. Select Origin Sets the current position to clamp origin 

3. Spindle Setup 

Sets the spindle function. 

1. Spindle rotation speed: 50-100% (adjusted in 10%) 

2. Start or stop spindle rotation 

4. Calibration 

1. Touch Sensor Adjusts touch sensor settings 

2. Probe Adjusts probe settings 

3. Pointer/ Flat Adjusts pointer/flat settings  

4. Pointer/Rotary Adjusts pointer/rotary settings 

5. Pointer/L-Tool Adjusts pointer/L-Tool settings 

5. Ring Inside Area Check 

Sets a method to check a engraving area for inner 
diameter:  

1. L-tool 

2. Laser pointer 

6. Chuck Revolution Rotates the rotary chuck 

7. Adjust 
Brightness 

1. Status LED Adjusts status LED brightness  

2. Inside LED Adjusts inside LED brightness 

3. Pointer Adjusts focus laser pointer brightness 

8. Vacuum Setup 

Set the chip collector. 

-Set the automatic control 

-Set the chip collector type: Dry/wet type 

9. Tool-Pos Recording 
Set the current position to enabled by the recording 
function 

10. Auto Zref on Repeat 

Sets an Auto Zref method at repetitive engraving:  

1. No measurement 

2. Height measurement 

3. Height measurement + area check 

11. Front cover 
Select whether to use the front cover. 

*Purchased separately. 
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(5) Display 
 

The display allows a user to check each feature and message and select a mode. Each icon appears differently 
depending on its function. The four buttons at the bottom represent different modes depending on circumstances.   
 

[Standby-Flat] 

 
 

                      
 

Status 

 
Bluetooth Appears if Bluetooth is enabled 

 

Auto Zref on 
Repeat 

• : No measurement 

• : Height measurement only 

• : Height measurement + area check 

 

Chip collector 
Power 

Chip collector ON or OFF: Nothing appears if turned off 

 
Focus Pointer Laser pointer ON or OFF 

 
Front cover Appears if use the front cover (*purchased separately) 

XY:#1-C X-Y Origin 

X-Y origin 

•[#1]: Clamp No. (1-5) 

•[C]: Origin No. (C: Center; origin No.: 1-8) 

100% Spindle power Adjust the spindle power. (50~100%) 

 

Mode 

 
Flat Mode Switch to flat mode 

 
Rotary Mode 

Switch to Rotary mode 

• The mode changes in sequence (OUTER DIAMETER → 
INNER DIAMETER → OUTER DIAMETER) in a loop whenever 
the button is clicked. 
• Switched to the INNER DIAMETER mode instantly if double-
clicked 

 
Tool change Switch to tool change mode 

 
Auto focus 

Moves to the camera focus 

• Moves to the view position after height measurement 

• Refreshes the camera display at MagicEngrave. 

*Able to use feature after enabling MagicEngrave. 

 
  

Status 

Mode 

Button 
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[Move Mode – Flat] 

Press  button in the STANDBY mode. Then, the mode is switched to [MOVE]. Then, control 

the position of each axis, using the above buttons.   
  

 

                 
 

Message X-Y Position 

The position is marked on the message differently depending 
on the Y-axis mode:  

•Y→Y: X-Y axis position 

•Y→Z: Z-axis position 

•Y→A: A-axis position 

 

Mode 

 
Standby Mode 

• Switch to the STANDBY mode  

• Automatically switched to the [STANDBY] mode if nothing is 
entered for about 10 seconds under the [MOVE] mode 

 
Save Origin 

Saves the current position as the XY origin 

*Short press: Temporary save / 

*Long (more than 2 seconds) Press: Persistent save 

 Y-axis movement mode:  Save XY Origin 

 Z-axis movement mode:  Save Z Origin 

 A-axis movement mode:  Save A Origin 

 
Laser Pointer Turns ON/OFF the laser pointer 

 

UP-DOWN 
Button Settings 

The mode changes in sequence (Y-axis → Z-axis → A-axis → 
Y-axis) in a loop whenever the button is clicked. 

 

 →   →  

 

   

Button 

Message 

Mode 
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[Standby - Rotary] 

 

                 
 

Mode 

 
Rotary Mode 

Switch to rotary mode  

• : Change to rotary inner diameter mode 

• : Change to rotary outter diameter mode 

 
Finger Mode 

The mode changes in sequence (Flat finger → Round 
finger → cylinder) in a loop whenever the button is clicked. 

• : Flat Finger 

• : Round Finger 

• : Cylinder (Used for cylinder engraving / ring cutting) 

 
[Move Mode - Rotary] 

Press   button in the [STANDBY] mode. Then, the mode is switched to [MOVE]. 
 

 

                 
 

Message A-axis Position Displays the A-axis position 

 

Mode 

 
Standby Mode 

• Switch to the [STANDBY] mode  

• Automatically switched to the [STANDBY] mode if nothing is 
entered for about 10 seconds under the [MOVE] mode 

 
Save Origin 

Saves the current position as the origin 

*Short press: Temporary save / 

*Long (more than 2 seconds) Press: Persistent save 

• If  (A-axis mode): If the laser pointer is ON, the 
current finger’s laser pointer position is saved as the origin.  

• If  (Z-axis mode): The SAVE ORIGIN icon changes to 

‘ ’, and the curent Z-axis position is saved as the origin. 

  - Outer diameter mode: Z-axis origin of outer diameter 

  - Inner diameter mode: Z-axis origin of inner diameter 

Mode 

Button 

Button 

Message 

Mode 



28 

 

UP-DOWN 
Button Settings 

The mode changes in sequence (A-axis → Z-axis) in a loop 
whenever the button is clicked. 

 

 →  

 

[Engraving Mode] 

 

                    
 

Mode 

 Engraving Speed 
Control 

Reduces engraving speed by 1mm/s whenever the button is 
pressed. 

 

Increases engraving speed by 1mm/s whenever the button is 
pressed. 

 Spindle Speed 
Control 

Reduces spindle speed by 10% whenever the button is 
pressed. 

 

Increases spindle speed by 10% whenever the button is 
pressed. 

 

[Pause] 

 

                    
 

Mode 

 

Return back to 
Previous position 

Returns back to the previous position and resumes 
engraving. 

 
Tool Change Used for tool replacement. 

 
Resume Resumes engraving. 

 

  

Mode 

Button 

Mode 

Button 
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(6) Status indicator 
There is a built-in status indicator on the left and right bottom of the BB-E7 to indicate the device status, so you 

can easily check the device status. 
 

 
 

 

The status is displayed at the blinking speed of the status indicator, and the status expressed through the 

indicator is as follows. 
 

Status Blinking Interval 

Waiting  

Engraving  

Operating  

Notification  

Error  

 

If the button is pressed for a long time (2 second or longer), enter the menu mode. 

Select the [7. Adjust Brightness], and then press  button to run the menu.  

7. Adjust 
Brightness 

1. Status LED Adjusts status LED brightness  

2. Inside LED Adjusts inside LED brightness 

3. Pointer Adjusts focus laser pointer brightness 

And select the [1. Status LED] then press  button to run the menu. 

Status LED brightness can adjust by using the (Direction X) buttons. 
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(7) Exchanging Tools 
 

Do not allow any body parts or other objects onto the machine. The cutter of machine may 
cause serious injury during its operation. 

 
Please wear the safety glasses for safe.  
The cutter of machine may cause serious injury during its operation. 

 
 

[Spindle] 

Name Picture Quantity Usage 

T-wrench 

(2mm) 
 

1EA 
Tool for tightening/replacement of 

bolt. 

 

Just like the figure below, insert it to 2mm wrench on tool fixing bolt. Turn wrench to the left and loosen bolt. 
Grab tool by hands in advance so that the tool does not fall on the bottom and pull out tool downward by pushing 
the tool from the top. After replacing the tool, tighten it by using wrench bolt and fix it 

 
 
When loosing tool fixing bolts, hold the tool with your hands and loose the bolts to avoid dropping 
the tool on the floor and causing damage to it.  
 

 

[L-Tool] 

Name Picture Quantity Usage 

L-wrench 

(1.5mm)  1EA 
Tool for tightening/replacement of 

bolt. 

L-tool fixing bolt 

(M3x4)  3EA L-tool tip fixing bolt 

 

Just like the figure below, insert it to 1.5mm wrench on tool fixing bolt. Turn wrench to the left and loosen the 
bolt. Grab tool by hands in advance so that the tool does not fall on the bottom and pull out tool downward by 
pushing the tool from the top. After replacing the tool, tighten it by using wrench bolt and fix it. 
 

\  

13~20mm 
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(8) Tension  

   
 
[Setting Machine Pressure Lock] 
When cutting materials or engraving materials with a V cutter, lock the tension. Then, vibration during engraving 
will be reduced and it will improve the quality of engraving or cutting and extends the life cycle of the tool.  
If you turn the tension pressure lock to the clockwise, the tension pressure locked, and turning it to the 
counterclockwise, the tension pressure is released. 
 

         
[When using endmill/ V-cutter etc.]                  [When using diamond/ carbide tip] 

 
After wards, when engraving with the diamond/carbide tip tool, it needs more pressure. So tension 
pressure lock should be released. 

 
[Pressure Adjuster] 
When engraving with a diamond/ carbide tip, the engraving depth is adjusted with pressure. This has the same 
effect as the engraving depth designation when creating the tool path. If you turn the pressure adjuster to the 
counterclockwise, the pressure increases, and turning it to the clockwise, decreases the pressure. 

 
 
 

            
     [Pressure increase]                        [Pressure decrease] 
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(9) Replacing the Spindle Belt  
 

The spindle belt transfers the rotation power of the spindle motor to the spindle to turn the 
engraving blade. If the spindle belt is worn out, the surface is cracked and slippery. So it 
cannot deliver the power of the spindle motor properly. In this case, the number of rotation 
decreases, or it causes poor engraving quality. 
 
 

[Spindle Belt Size] 
5Ø  (50mm) 
 

[Replacement Cycle] 
The lifespan of the spindle belt varies depending on usage and conditions. Generally, it should be replaced every 
2-3 months. 
 

[Spindle Belt Replacement Method] 
 
1. Remove the L-tool fixing bolt by rotating it counterclockwise. 

 
 
2. Remove the [head cover] by loosening the 4 bolts using a 2.5mm wrench. 

      
 
3. There is a red rubber belt on the front head of the machine. Replace this belt with a new belt. 

 
 
4. Reassemble the [head cover] in order of 3 to 1. 

  

Spindle belt 
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4. Installation 
※ Please follow the instruction below in order to use the solution.  

※ This program requires Windows OS 7 or higher.  

 

(1) Installation of marking machine 
 

BB-E7 is a desktop marking system. Marking cannot be done with only the machine. 

It should be connected to the personal computer, and the program provided should be used together for marking.  

 
     

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Plug the USB cable into the port on the back of the machine and computer’s USB port.  

Plug the power cable into the outlet. And switch on the machine.  

USB Cable 

USB Cable  Computer 

Power Cable  Outlet 
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-Power switch 

 

 
 

 
Power Turns ON/OFF the machine. 

 

 

-Emergency Switch 

 

※If the machine is not turned on, check the emergency switch. 

 

          
 

  

Push 

Turn OFF Turn ON 

Turn the button 
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(2) Program installation 
Insert the USB into your computer`s USB port, Follow the instructions below to install the software. Install 

program will be automatically run and program installation will proceed in the following order. If the program does 

not run automatically after the USB is connected to your computer, run Install program on My Computer’s USB 

drive. 

1. Setup wizard. 

 

2. Select installation folder. 

 
3. Confirm installation. 

 

4. The file is copied onto the hard disk. 

 

5. USB driver setup wizard. 

 

6. Check [I accept the agreement], then click 

[Next]. 

 

6. After check the [Status: Ready to use], Click “Finish” 

button to complete. 

 

7. Click “Finish” button to complete program 
installation. 
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- Program Description 

Once the installation is completed, the following icon appears on the desktop. The description of the icon is as 

follows: 
 

 

  

 

As a design & marking software program, it features the following functions: marking 

design, marking option, Toolpath setting, transfer of Toolpath data. 
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(3) Front cover  
-Optional (Purchased separately) 
 
[How to install the front cover]  
1. Set the [Bolt (M4x12) – M4 Washer – M4 Spring washer x 2] in order. 
 

 
 

2. Secure the [1] with spacer. Secure the spring washer so that it fits into the front cover hole. 

 
 
3. Secure the cover stopper with bolt (M4x6). 

 
 
4. Secure the other side in the same way.  

  

M4 Spring washer x2 

M 4washer x1 

Bolt(M4x12) 

Spacer 

Front cover 

Front cover hole 

Side cover: When using tailstock, remove the side 

cover by using 2.5mm wrench. 
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5. Press the button on the keypad to enter menu mode. And select the [11. Front Cover] menu to use the 
function. Then check the display of the front cover icon on the LCD. 
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(4) IO port 
※ The external IO port input to the machine must be 5V, 50mA or less. 

The BB-E7 uses a LAN cable to receive external signals through the IO port on the back to control operation. 

 

        
 

OUT 5V DC OUT +5V power necessary to connect external devices. 

IN START/STOP 
Start or stop the engraving upon +5V signal input from an external 
device. 

OUT VACUUM ON/OFF 
When the chip collector is ON, +5V (High) is output to an external 
device; and, if OFF, GND (Low). 

OUT 
General-purpose 

Output 
Output DC 5V to General-purpose output port. 

IN 
Receive Serial 

Communications 
Receive port for serial communication with external devices. 

OUT 
Transmit Serial 

Communications 
Transmit port for serial communication with external devices. 

**OUT: Signal received by an external device 
**IN: Signal received by the equipment 

  

IO Port 
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5. Operation of the marking machine 
 

Turn on the machine. Then, the system performs self-diagnose as follows. Unless a problem is found, it goes into 

a standby mode with confirmation sound.  
 

(1) Self-diagnose procedures when the system is turned on 
1) If a certain axis is detected by the sensor, it is moved to leave the detected area.  
2) Check probe sensor and return to the Origin point 
3) Check Z-axis sensor and return to the Origin point 
4) Check Y-axis sensor and return to the Origin point 
5) Check X-axis sensor and return to the Origin point 
6) Confirmation sound and standby 

 

(2) Marking procedures 
 

1) Turn on the marking machine. 

    ※ If the machine does not turn on, check the emergency switch. 
 

2) Start the program and connect it to the machine.  

 
 

3) Put the material on the work area.   

 

4) Prepare the design to mark, and then create the toolpath. 
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6) Click the [Machine] button and send the marking data. 

 
 
 

7) Press the start button on the machine to begin the engraving process. 
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Program Usage Description 
Run the program, then a window will appear as shown below. The program window is different in accordance with 

modes. The names of parts for each case are as follows. 

 

◈ Program screen 

 
 

◈ Text input mode 
 

 Press   [Text Input] button and click the screen or double click on the selection mode to switch to text 

input mode. 

  
  

Text property 

Work area 

Template 

list 

Menu 
Toolbar 

Template category 

Screen zoom in/out tools 

Data 

output 

Cursor (text input mode) 
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◈ Object selection mode 

After entering the text, click  [Selection] button with a mouse or right-click the work area. Then, the entered 

text object is selected and it switches over to selection mode. Double click the selection mode to switch it to text 

input mode. 

  

 

◈ Object rotation mode 

If the selected object is clicked once more, the mode will switch over to object rotation mode. 

 

  
  

Object property 

Object selection mode 

Rotation registration information 

Object rotation mode 



45 

1. Toolbar 
 

◈ Alignment tools 

 

 
 

 [Line/Curve]  

 

Click a certain point and drag it to make a dot line appear. Designate the 

distance and click with the mouse and then right-click to create a straight 

line. Then, press “Ctrl” key on the keyboard and move the mouse to create 

a horizontal line or a vertical line.  

 

Click on a certain point and designate a distance. Drag while clicking and 

holding the mouse to make a curve appear. Right-click to create a curve. 

 

 [Circle/Oval/Pie] 

 

Click and hold the work area with the mouse and drag it to designate the 

size of a circle. Then, press “Shift” key and drag it to create a perfect circle.  

 

Click  button on the circle object property window to convert into an 

arc. The starting/ending angle can be designated and those angles can be 

adjusted by dragging the starting/ending point of the arc with the mouse. 

Then, click  button to create a reversed image.   

 

Click  button on the circle object property window to convert into a 

pie (a filled arc). The starting/ending angle can be designated and those 

angles can be adjusted by dragging the starting/ending point of the pie with 

the mouse. Then, click  button to create a reversed 

image.   
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 [Rectangle] 

 

Click and hold the work area with the mouse and drag it to designate the 

size of a rectangle. At this time, press “Shift” key and drag it to create a 

square. 

 

Determine the curvature of each edge on the rectangle object property 

window or drag the rectangular edge with the mouse to convert it into a 

rectangle with round corners. 

 

Click  button on the rectangle object property 

window and adjust the curvature of each corner individually.  

 

 [Polygon] 

 

Click and hold the work area with the mouse and drag it to designate the 

size of a polygon. 

At this time, specify the number of vertex on the polygon object property 

window to change it.  

 

 [Mirror] 

       

Reverse the left/right of the selected object. 

 

 [Rotation] 

           

If the selected object is clicked once more with the 

mouse, it will switch over to the object rotation mode. 

Then, rotate the object by dragging it with the mouse or 

arrow keys on the keyboard. 

 

 [Invert color] 

         

Invers the color of the selected object. 

 

 [90˚CW] 

          

Rotate the selected object by 90˚.  
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 [Horizontal center in page] 

          

 [Vertical center in page] 

          

 [Center in page] 

            
 

  



48 

[Alignment option] 

 
 

 

 

Alignment 

 
Align to the left of base object 

 
Align to the center of base object 

 
Align to the right of base object 

 
Align to the top of base object 

 
Align to the center of base object 

 
Align to the bottom of base object 

Adjust horizontal gap 
 

Align horizontal gap between objects uniformly 

Adjust vertical gap 
 

Align vertical gap between objects uniformly 

Same size 

 
Make same width 

 
Make same height 

 
Make same size 

Alignment 
 

Horizontal center in page 

 Vertical center in page 

Order 
 

Bring to front 

 
Send to back 
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◈ Object tools 

 

 

      
 

 [Barcode] 

Create the barcode object. 
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 [Design sample] 

Import design sample or save current object as design sample. 

 
 

What is a design sample? 

It means design objects saved in the design sample library. The design sample is easily and 

quickly imported from the design sample library and freely edited. 
 

 [Selection] 

You can select the object created in the work area to adjust its size and location or to change the object’s property. 

Only the selected objects are subject to change their options such as location, size, etc. In the text input mode, 

switch over to selection mode easily by right-clicking the work area. 

        
[Object selected]                  [No object selected] 

 

 [Text input] 

If  button is pressed and the work area is clicked with the mouse, characters can be entered. Double 

clicking in the selection mode is an easier way to switch over to the text input mode. 
 

               
Cursor (Text input mode) 

 

Press  button and drag a character to edit with the mouse for partial selection. Then, adjust its font and size. 

 
 

[Mouse drag] 
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 [Circular text] 

Create text objects along a circle. 

 
 

 

 [Drawing pen] 

Drawing can be performed by dragging the mouse.  

The thickness of the drawing line can be adjusted in the drawing object property window. 

 
 

 [Outline stroke of object] 

You can insert an outline in the selected object. 
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 [Invert color of overlapped area] 
 

When two or more objects are overlapped, the color in overlapped area can be inverted.  

Move the target object over the first object after clicking button, then overlapped area’s color will be 

inverted. 

                

When inverting text, drag the target object over the text after clicking  button.  

 

 
 

 

 
[Automatically invert color in overlapped area] function inverts the color of underlaid object. 

If the color is not inverted, select [Layout menu → Order → Top Most] and place the underlaid 

object above the other object. 

 

 

 [Image] 

Import image (bmp, jpeg, gif, png … etc.). 
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 [Line eraser] 

Erase the line of a created object.  

Move the mouse over the line of an object, then click the line. The line will be erased (Some objects cannot be 

erased with the Line eraser tool). 

 

 
 

◈ Toolpath 

Please refer to [4. How to engrave for each toolpath] for details. 

 

 
 

Toolpath? 

Toolpath is a pathway where tool passes by for marking.  

Toolpath is usually displayed in red color and marking tool moves along the pathway as it 

engraves.  
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◈ Origin point setting tools 

 
 

 [Left top origin point]  [Left bottom origin point] 

  

 [Center origin point] 
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◈ Basic tools 

 

 
 

 [New document] 

Open a new page.  

 
 

 [Open] 

Open a file in “*.dgn” file format. 

Select a file on the “Open” window and click “Open” button. 

 

 [Save document] 

Save the design drawn on program as “*.dgn” file format. 

Choose the location (folder) in which the file will be saved and enter the file name before clicking “Save” button. 
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 [Print] 

Print the design drawn on program. 

 

 [Cut]  

Cut the selected object.  If Ctrl+X is pressed on the keyboard, the same function will be executed.  
 

           
Ctrl + X                 Ctrl + V 

 

 [Copy] 

Copy the selected object. If Ctrl+C is pressed on the keyboard, the same function will be executed. 
 

           
Ctrl + C                  Ctrl + V 

 

[Duplicate Horizontally or Vertically…] 

If more than one of the same objects is needed, multi-copy the object at regular intervals by clicking [Edit → Copy 

→ Duplicate Horizontally or Vertically…] or pressing  icon in toolbar.  
 

    
 

            
 

 [Paste] 
 

Paste the cut or copied object. 

If [Ctrl+V] is pressed on the keyboard, the same function will be executed. 
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 [Undo / Redo] 

-Undo: Restore the work recently done to its previous state.  

The number of undo steps can be adjusted with [Menu] → [Tool] → [Option] → [General].  

 

                  
 

-Redo: Re-execute the undone work.  

                  
 

                                                                          

  

Change font Undo 

 

Change font Undo 
Redo 
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◈ Screen zoom in/out/move tools 

 

 

 

 [Zoom in] 

The screen is zoomed in by one level. 

             
 

 [Zoom out] 

The screen is zoomed out by one level. 
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 [Zoom in/out ratio] 

If desired screen ratio is selected, the screen in the size of the selected ratio will be shown. 

 
 

 [Magnifier] 

Drag a certain spot with the mouse to enlarge it.  

                 
 

 [Fit to object] 

Enlarge the selected object to make it fill in the screen. 

                
 

 [Fit to page] 

Adjust the page size to see the whole work area.  
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 [Panning] 

Drag the screen with the mouse to move it. 

              
 

2. Text object property 
If any text object is selected, the property of the text object will appear on the left of the screen.  

 
 

 [Font] 

 

Designate font. Either click the font’s arrow or click “Preview” button to designate font. 

 

 

 
 

 

 
 

*If you right click the font preview window, a menu appears. Click “Show 

Font List”, then you can designate the fonts that will be used in preview.  

  

[Mouse right button click] 
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 [Size] 

Adjust the size of the selected text. Either press the arrow button of [Size] select the size of the font or press 

 [size] button to adjust the size by one level.  

                 
 

 [Bold] 

Change text style to bold.  

               
 

 [Italic] 

Change the text style to italic. 

               
 

 [Reduce or increase font weight by one level] 

Adjust the weight of font. 

                     
 

 [Symbol] 

Insert symbols. 
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   [Text change] 

The entered text of the selected object can be displayed and changed. Edit the text on the text field or press  

button to change the text more easily when several text objects are selected.  

          
 

 
 

 

 [Text Alignment] 

 

 [Align to left] 

Align characters to the left in the text box. 

 

 [Align to center] 

Align characters to the horizontal center in the text box. 

 

 [Align to right] 

Align characters to the right in the text box. 
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 [Both] 

Align characters to the both direction evenly in the text box. 

 

 [Align to top] 

Align characters to the top in the text box. 

 

 [Align to center] 

Align characters to the vertical center in the text box. 

 

 [Align to bottom] 

Align characters to the bottom in the text box. 

 

 [Horizontal text ] 

Arrange characters horizontally. 

 

 [Vertical text] 

Arrange characters vertically. 

 

 

Move the selected character horizontally (left, right). 

 

 

Move the selected character vertically (up, down). 

 



64 

 

Adjust the width of the selected character. 
 

 

 

Rotate the selected character. 
 

 

 

 [Position/Size] 

 

 [Line and Fill Shape] 

 

Designates the location of the selected object 

 

Designates the size of the selected object 

 

When “Keep Ratio” is checked, width and height of the selected object 

is maintained at the same ratio. 

When “Keep Ratio” is un-checked, width and height of the selected 

object can be adjusted separately.  

 Line thickness of the selected object 

 Line type of the selected object 

 Line color of the selected object 



65 

 

 

3. Rotation tool property 
If the selected object is clicked once more, the mode will switch over to object rotation mode. 

 
 

 [Rotation] 

 

  

 
Color filled inside of the selected object 

 Shape filled inside of the selected object 

 

Rotate the selected object by designated angle. Enter the desired 

angle of rotation, and then press arrow button.  The object is rotated 

by the angle entered. 

 
Rotate the selected object at the same angle as entered. 

 

Rotate and add a new object at the same angle as entered 
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4. How to engrave for each toolpath 

 

Toolpath? 

Toolpath is a pathway where tool passes by for marking. 

Toolpath is usually displayed in red color and marking tool moves along the pathway as it 

engraves.  

 

 [Cut-out toolpath] 
Creates a toolpath that will cut out the selected object. The toolpath boundary will be wider than the boundary of 
the selected object depending on the thickness of the tool. * This toolpath must be used when cutting. 

         

 [Outline toolpath] 

Creates a toolpath that will engrave the outline of the selected object. 

       

 [Hatching toolpath] 
Creates a toolpath that will engrave inside of the selected object. 

        

 [Single line toolpath] 

Creates a toolpath that will engrave the center line of the selected object. 

        
 

“Single line toolpath” process may cause the deviation of the center line. 

Thus, it is recommended to use thinner lined font to reduce the deviation.  
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 [Boundary-line toolpath] 

Creates a toolpath that will engrave the boundary of the selected object. 

         

 [Inline toolpath] 

Creates toolpath that will engrave inline of the selected object. 

         
 

The toolpath is created on inner line that is placed within the boundary of the selected 

object. 

 

 [V-cut toolpath] 

Creates toolpath that will engrave V-cut groove. 

        

 [Convert object to toolpath] 

Convert selected object to toolpath. It’s not necessary to designate toolpath setting every time and they will be 

automatically set with their preset values.  

 

  

Inline 

Outline 
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 [Photo impact engraving toolpath] 

Creates a toolpath that will engrave an image with dots. 

          

[Scan-line toolpath]  

Creates toolpath that will engrave inside area of the target object’s boundary. 

“Scan line toolpath” might be similar to “Hatching toolpath”, but it is rather used for logos, patterns or objects with 

larger area.  

         

          
 

 [Contour line toolpath] 

Creates a toolpath that will engrave the selected object with contour lines. 

        
 

 [Photo halftone engraving toolpath] 
This converts an image into a half-toned image and engraves the object in dots or horizontal lines using V-cut tool. 
This process is only applied to models with rotating-spindle function like BB-E7, E4 etc.  

           [Dot] 

                                     [Horizontal Line] 
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Half-toned engraving? 
Half-toned engraving converts light and dark area of a picture or image into lines or dots with 
different sizes to express a fine image.  

 

 

 [Simulate toolpath processing] 

The predicted image of the toolpath result processed by the selected tool is shown. 

The following is an example. 

         

 [Show toolpath only] 

Only toolpath is shown on the screen with temporarily hiding all of the other objects. If this button is pressed once 

again, all objects will be seen again.   
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5. Create Toolpath 
 

 

Tools in [Tool] option may differ according to types of models. 

Tool 
Designate a tool to be used for engraving. Each tool setting value can be 
changed by pressing Edit or Add button. 

Preset 

Hatching gap, depth, engraving speed and others are pre-set for each 
engraving option. Therefore, it is not necessary to designate hatching gap, 
depth, engraving speed and others every time and they will be 
automatically set with their pre-set values. Each engraving option value 
can be changed by pressing Edit or Add button. 

Direction 

The followings are shown only on hatching tool path. 

 : A tool path is created in the horizontal direction 

 : A tool path is created in the vertical direction 

 : A tool path is created in the left diagonal direction 

 : A tool path is created in the right diagonal direction 

 : A tool path is created in the cross hatched direction 
※ This toolpath is not recommended due to possible damage to materials 

with plated surface. 

Option 

Depth 

Engraving: It does not mean the actual engraving depth but refers to 
“applied pressure” and the higher depth value, the bigger the 
applied pressure.  

Cutting: Designate an engraving depth actually used for using rotation 
tools. 

Z Pitch 

When cutting the engraving depth little by little, designate the depth. When 
cutting thick materials with a thin tool, this option is necessary. 

 

Z Pitch 

Actual engraving 
depth 
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Hatching 

gap 

Designate hatching gap. 

 
0.1mm       0.2mm      0.3mm 

Margin 

Designate a margin between object outline and toolpath. 

 
0.1mm       0.2mm       0.3mm 

Engrave 

outline 

If this option is un-checked, a toolpath for only the inside of the selected 
object is created.  

 

Speed 

XY speed Designate a speed at which XY axis will move during the engraving. 

Z speed Designate a speed at which Z axis will move during the engraving. 

Engraving speed is displayed in colors according to tools or engraving options. 
 

Move  
Option 

Z 
clearance 

This designates the height to be applied for the clearance between the tool 
and the surface of material when moving to other engraving location.  
When moving to another engraving location, it is necessary to lift Z axis to 
prevent the tool from coming in contact with the material surface before 
moving. For this, designate the height to be applied at this time. 

 

Z dwell 
time 

This designates no-load rotation time of end-mill and V-cutter after they 
reach the target depth and before moving to X, Y axis point.  
It is possible to damage the tool as rotation speed reduces while engraving, 
So set up the Z-dwell time to recover the full rotation speed before 
engraving. 

✽Recommended time: 0.5 ~1 second. 

Transmit Toolpath output window is displayed 

 
  

Z Clearance 
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(1) Tool: Add/Delete/Edit 
If “Edit” button is checked, Add/Delete/Edit buttons will appear. 

 

 Designate the name of a tool to be added along with its type and other options like tip width, then 
click “OK” button. The tool will be added to the tool selection list. 

 

 Select a tool from the list and click “Delete” button to delete the selected tool from the list. 

            

 Select a tool for modifying and click “Edit” button. If “OK” button is clicked after option is modified, 
the modified value will be saved.  
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(2) Engraving Option: Add/Delete/Edit 
If “Edit” button is checked, Add/Delete/Edit buttons will appear. 

 
 

 Enter a name to the engraving option setting window and designate hatching gap, engraving depth 
and speed before clicking “OK” button. The option will be added to the engraving option selection list. 

           
 

 Select an option to be deleted and click “Delete” button to delete the option from the list.  

           
 

 Select an option to be modified and click “Edit” button. If “OK” button is clicked after option is 
modified, the modified setting value will be saved.  

 
  



74 

6. Toolpath object property 
If toolpath object is selected, the toolpath object property window will appear on the left of the screen to allow 
the user to adjust its depth and speed once again. 

 
 

Depth 
Engraving: It does not mean the actual engraving depth but refers to “applied 

pressure” and the higher depth value, the bigger the applied pressure.  
Cutting: Designate an engraving depth actually used for using rotation tools. 

Z pitch 

When cutting the engraving depth little by little, designate the depth. When cutting 
thick materials with a thin tool, this option is necessary. 

 

XY speed Designate a speed at which XY axis will move during the engraving. 

Z speed Designate a speed at which Z axis will move during the engraving. 

Z clearance 

This designates the height to be applied for the clearance between the tool and the 
surface of material when moving to other engraving location.  
When moving to another engraving location, it is necessary to lift Z axis to prevent 
the tool from contacting with the material surface before moving. For this, designate 
the height to be applied at this time. 

 

Z dwell time 

This designates no-load rotation time of end-mill and V-cutter after they reach the 
target depth and before moving to X, Y-axis point.  
It is possible to damage the tool as rotation speed reduces while engraving, So set 
up the Z-dwell time to recover the full rotation speed before engraving. 

✽Recommended time: 0.5 ~1 second. 

Engrave twice Engrave the design twice.  

Z Pitch 

Actual 

engraving depth 

Z Clearance 
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7. NC data output 
(1) Transfer the data after creating a tool path 

Select toolpath and click machine button on the top-right of the screen to transfer the selected toolpath to the 

BB-E7. 

 
 

 
On the NC output window, select a measuring method and other options, then click “Start Engraving” button to 

start transferring the toolpath to the selected machine. 

 
 

Toolpath order 

When two or more toolpaths are selected for engraving, they will be 
placed in order. The order can be adjusted by [Up], [Down] button on 
the right.  

Surface height  
measurement 

Surface 
height 

Measure material height only. 

 

Skip 

Do not measure its height. In this case, the previously measured 
height is used. If the material is not removed from the clamp during 
the previous engraving work, the measuring time can be saved with 
this option.  
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Horizontal 
slope 

Measure material’s horizontal gradient. 

 

Vertical 
slope 

Measure material’s vertical gradient. 

 

Surface 
slope 

Measure material’s top, bottom, left and right gradient. 

 

Material surface 

Flat Engraves flat-surfaced materials. 

Uneven Engraves curve-surfaced materials. 

Multiple engraving 
Engraves materials repeatedly in constant vertical/horizontal gap. 

✽Usually optional vise is used for this automatic engraving. 

Simulate engraving 
This displays engraving simulation on the material by using laser 
pointer to assure its correct pathway.  

Adjust engraving position 

Designate whether to re-adjust the engraving location. If this option is 
selected, the laser pointer will be turned on to allow the user to adjust 
the engraving location before engraving. If this option is not used, 
engraving will initiate immediately.  

Move to vise automatically 
Automatically moves to the flat or rotating vise according to selected 
template.  

Touch-Mark-Free 
Measurement 

Prevents height measurement points from remaining. 

Turn on External Device Enables external device operation automatically. 
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✽ “NC output” window when selecting ring template.  

 
 

Surface height 

Measure material height. 

 

Multi-point-
measurement 

Measure material height by dividing the whole material into several parts 
(up to 5 times) 

Outside Engrave on the ring’s ring outer diameter. 

Inside Engrave on the ring’s ring inner diameter. 

 
Place the material on the flat chuck finger. 

 
Place the material on the round chuck finger 
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(2) Transfer the toolpath data immediately after entering characters 
You can transfer the selected object immediately without creating a toolpath. 
After create the design to be engraved, Click [Engraer] button on the right top without creating a Toolpath for 
immediate Marking. 

 
 

(3) Camera 
 

Activate the camera function. 

BB-E7 has a built-in camera filming marking areas. This camera takes the images of materials inside a marking 

area and sends the material images to the program along with their size and location data in order for users to 

design directly on the images of real engraving materials and set a marking size and location. 

 

[Camera positioning system specifications] 

-Filming area: 90mm x 70mm  

-Filming target: flat surface engraving unusable in rotary engraving 

-Camera resolution: 1600 x 1200 

-Precision: 0.2mm (*Precision is a calculated number. The actual precision is affected by calibration.) 
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Refresh Renew the camera image displayed in the MagicEngrave Program. 

Camera On 
Activate/Inactivate the camera function. 

When [Camera on], auto positioning is also used. 

AF See 8. Auto Focus for details. 

Image Adjustment 

Set the camera image options such as contrast, grayscale etc. 
 

 

Camera Viewer 

View the camera image in a new window. 

 

Camera Calibration 
Set the camera calibration. 

Please refer to [8.camera calibration] on calibration. 

Camera Selection 

Select your camera device. 

If there are multiple camera devices connected to the PC, by default, 

the camera for laser is set automatically, but you can select the device 

manually. 
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8. Auto focus 
BB-E7 has a built-in auto focusing system that automatically focuses on a surface to mark through a material 

height-sensing camera.  

 

* Must press the [AF] button to use the camera auto-positioning function. 

* If the material changes, it will need to be refocused. 

*Able to use feature after enabling MagicEngrave program. 

 

1. Press [AF] on the program. 
 

 

① Clamp is move to the center. 

② Measure the height of the material 

③ Tool moves to the right end of the machine 

④ Software updates the camera image 

 

2. When press the [AF] button on BB-E7 operation buttons, press the [Refresh] button on the program to 

refreshes the camera display. 

                

                   
 

3. If you want to cancel the autofocus, press the  button on BB-E7. 
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Marking process 
 

 
 

1. Measure the size and height of a material.  

 
2. Place the material to be engraved to the center of clamp. 

 

 

3. Select the template, which is the most similar to the material to be engraved from the template category and 
enter the size of the material before clicking “OK” button. 

 
 

Maintain original size Uploads actual size of registered template, not the size entered by the user.  

Locate at original 
position 

The template is uploaded where it was initially created. Without this option, the 
template is uploaded at the center of work area.  

Fit page size to 
template 

Adjust the size of the page to be same as the template.  

 

Height 

Thickness 

Width 
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4. Once the template appears, press  [Text input] and click any target location with the mouse to enter 
text. 
 

 
 

5. Once entering text is completed, press  [Selection] on toolbar and enter the object selection mode to 

select the entered text. Then, edit the size, font and thickness of the object. If you want to place the object at the 

center of the work area, click  [Center in page] button. 
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6. Once the design is completed, click  [Hatching toolpath]. 

✽Click  on the right top without creating a Toolpath for immediate Marking. 

 
 
7. Select an engraving option and tool from “Hatching Toolpath” window and if necessary, designate gap and 

depth before clicking “Create Toolpath” button. 
 

  

                          
 

-Scan line toolpath-                            -Hatching toolpath- 
 
Better engraving quality is achieved by “Scan line toolpath” when engraving large area (Big 
size font or image etc.,) but this may require more time in the process.   
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8. Toolpath object is created. 

  
 

9. Click  button.  

 
 
10. Once “NC Output” window appears, specify how to measure the engraving materials. And then, click “Start 
Engraving” button. 
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11. Once the tool is moved to the center of the material and located, the engraving area can be verified and 
adjusted by using the direction key button. At this time, check the laser pointer while moving it for easier 
measurement and adjustment. 

 

Whenever the direction key is pressed, move the laser pointer to the left, top, 
right and bottom of the engraving area to show the area to be engraved. Check 
whether the area to be engraved is outside of the materials surface. If so, adjust 
the location by using the direction key.  

 

The laser pointer moves the area to be engraved to the left, top, right or bottom 
according to current location. If the current location of the laser pointer is left, 

then, press   key to move the area to the left. 

 
 

12. After the location of engraving is decided, press and hold  button until it beeps (more than 3 seconds) 
to start the engraving and close the engraver cover. 
 
  

Work area 
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Marking process of ring Inner/outer diameter 
 

 
 

1. Measure the width and diameter of a ring to be engraved.  

 

                                         
<Outer diameter marking – Ring outside size>             <Inner diameter marking – Ring inside size> 

 

 
2. Insert the ring into the chuck finger as shown below, and tighten the rotation clamp to fix it. 

           
[Ring outer diameter engraving]        [Ring inner diameter engraving] 

 

[Object position]  

     

 

[Engraving direction]  

Since the engraving direction is as shown in the picture below, check the direction of the material and fix it. 

  

Rotary 
Fixing 

Part  

1
 

2
 

Width 

Diameter 

Width 

Diameter 

1 

2 
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3. Double click “Ring” template in the object property window. When [Insert Rotary Object Template] window 

appears, select the outside/inside, Then enter the measured width and diameter of the ring and click “OK.” 
 

 

4. The template appears at the center of the screen. And select  [Text Input] on the toolbar, and click the 

work area using mouse and enter text to be engraved. 

 
 

5. After entering text, press  [Selection] on the toolbar to enter the object selection mode. Select the text, 

and edit the size and font of the object. To place the object at the center of the work area, click  [Center in 

Page] button. 

    
Handle for adjusting gaps between characters? 
A function adjusting gaps between characters by dragging characters to target positions.  

Handle for 
adjusting 

character gap 
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6. Once design is completed, click  [Hatching Toolpath] button.  

✽Click  on the right top without creating a Toolpath for immediate Marking. 

 
 
7. Once “Hatching Toolpath” window appears as shown in the picture below, select tool, toolpath gap and depth, 
and click “Create Toolpath” button. 

 
 
8. The “Toolpath” object is created as shown below and usually marked with red line on the screen. Scroll the 
mouse wheel to enlarge the toolpath object, and if it is not the desired toolpath, delete the toolpath and create it 
again by adjusting the toolpath option. 

 
                     [Toolpath creation]  
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9. After selecting one or more created toolpaths, click  button. 

 
 
10. Once “NC Output” window appears, specify how to measure the engraving materials. And then, click “Start 
Engraving” button. 

 
 

Surface height 

Measure material height. 

 
 

Multi point 
measurement 

Measure material height by dividing the whole material into several parts(up 
to 5 times) 

Outside Engrave on the ring’s ring outer diameter. 

Inside Engrave on the ring’s ring inner diameter. 

 
Place the material on the flat chuck finger. 

 
Place the material on the round chuck finger 
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11. Once the tool is moved to the center of the material and located, the engraving area can be verified and 
adjusted by using the direction key button. At this time, check the laser pointer while moving it for easier 
measurement and adjustment. 

 

Whenever the direction key is pressed, move the laser pointer to the left, top, 
right and bottom of the engraving area to show the area to be engraved. Check 
whether the area to be engraved is outside of the materials surface. If so, adjust 
the location by using the direction key.  

 

The laser pointer moves the area to be engraved to the left, top, right or bottom 
according to current location. If the current location of the laser pointer is left, 

then, press   key to move the area to the left. 

 
 

12. After the location of engraving is decided, press and hold  button until it beeps (more than 3 seconds) 
to start the engraving and close the engraver cover. 
 

  

Work area 
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Photo marking 
 

 
What is photo marking? 

This is a marking method to display the shade of image with dots. 

 

1. Place the material on the clamp. 

 

2. Click  [Image] to import an image for marking.  

 
 

3. Adjust the size and location of the image. 

 
 

 

 

[Mouse drag] 
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4. [Clipping Mask] function enables cutting out target area extracted from the image.  

 Create a shape to designate the target area and drag it on to the image.  

  
 

5. Drag a mouse to select the target area and the whole image. Or select [Menu] → [Edit] → [Select All]. 
 

 
 

6. Select [Menu] → [Transform] → [Make Clipping Mask]. The target image remains except the external image. 
 

 
 

[Mouse drag] 

[Mouse drag] 
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The whole actual image is already saved in the file, not erased. 

 

7. Click  [Photo Impact Engraving Toolpath] button. 

✽Click  on the right top without creating a Toolpath for immediate Marking. 

 
 

8. Adjust marking option in photo marking option window. 

 

✽ The black area cut by clipping mask is not being engraved. 
 

When marking a photo, the bright part (white area) of the image is expressed in dots.  Since the darker 

image shows higher quality, adjust the brightness to be darker. Normally, dot ratio 10-20% shows the best 

marking quality for a portrait. The optimal image condition depends on the brightness of background of 

the image.  Adjust the image monitoring the image preview and the dot ratio. 

If ‘image adjustment’ is confusing, click “Recommend the best” button to automatically adjust the image. 
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9. Click “OK” button to create toolpath for photo marking. And set the marking option, then click [Engraver] button. 

 
 

When marking a photo, the white area of the image appears as a dot. So the result of the toolpath is 

shown as a negative image. 

 

10. Once the tool is moved to the center of the material and located, the engraving area can be verified and 
adjusted by using the direction key button. At this time, check the laser pointer while moving it for easier 
measurement and adjustment. 

 

Whenever the direction key is pressed, move the laser pointer to the left, top, 
right and bottom of the engraving area to show the area to be engraved. Check 
whether the area to be engraved is outside of the materials surface. If so, adjust 
the location by using the direction key.  

 

The laser pointer moves the area to be engraved to the left, top, right or bottom 
according to current location. If the current location of the laser pointer is left, 

then, press   key to move the area to the left. 

 
 

11. After the location of engraving is decided, press and hold  button until it beeps (more than 3 seconds) 
to start the engraving and close the engraver cover.  

Work area 
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Cutting process 
-Cutting clamp and nose are purchased separately. 

 
 

Do not allow any body parts or other objects onto the machine. The cutter of machine may 
cause serious injury during its operation. 

 
 

Please wear the safety glasses for safe.  
The cutter of machine may cause serious injury during its operation. 

 
 

[Set the machine before the cutting] 
 
1. Lock the tension by turning the pressure lock to the clockwise. 

 [When using endmill/ V-cutter etc.] 
 
2. Assemble the cutting nose and make the cutting nose’s tool hole is placed in front of the tool fixing bolt.  

        
 
3. Replace the tool with a cutting tool. 
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4. Put a flat plate (Ex: ruler) under the cutting nose as shown in the picture below and release the tool fixing screw 
with 2mm wrench. Lower the tools until it touches the plate and fix the tool in place. 

                 
 

5. Press on the keypad and get into the [MENU] mode. Select a [1. Tool Change] and press  button to 

measure the tool depth.  

 
6. Set the cutting clamp and place a material to be cut on the clamp.  
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[Program] 

1. Press  [Text Input] on the toolbar to enter the text input mode, and click the work area you want and 

enter the text. 

  
 

2. After entering text, press  [Selection] on the toolbar to select the text and designate the font. 

 
 

Adjust the text to the desired size. The size can be adjusted by using an object handle (a square in the picture 

below) as shown below, or from the object property window. 

 

 

 
 

 

 

  

Object Handle 
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3. Drag the text gap adjustment handle (a square in the picture below) with the mouse to narrow or widen the gap 

between the characters. 

 
 

 

 

If the gap of some characters is partially adjusted, press  [Text Input] button and drag the mouse to select 

the characters you want. Drag a text gap adjustment handle with the mouse and adjust the gap. 

 

           

              [Enter text]                    [Press  button and click with the mouse] 
 
 

              
[Select characters]                             [Adjust character gap] 

        
 
4. Insert a type of ring connected to the characters from the design sample section. 

*Design sample: Click  or [Menu] → [View] → [Design sample].  

 
 

5. Select a type of ring and double click it to load in the work area.  

 
 

Object Handle 

[Mouse drag] 

[Mouse drag] 
[Mouse drag] 
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6. [Copy] and [Paste] the ring type, then guideline for a location of the ring appears.  Adjust the location and click 

the spot.  

Copy the target object by pressing [Ctrl+C] 

 
 

 

Paste the target object by pressing [Ctrl+V] 

 
 

 

Confirm the location and click the spot. 

 
 

7. Select all the objects for the design, right-click on it to see the menu and select [Group].  

 

✽Selecting the whole objects: Drag the object with mouse or select [Menu] → [Edit] → [Select All]. 

 

8. Once the design is completed, click  [Cut-Out Toolpath].  
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9. Once the “Cut-Out” window appears as seen in the figure below, select tool to be used for the cutting, enter the 

measured material thickness and the other options and click “Create Toolpath.”  

 
 

Option Depth 

Designate the thickness for cutting. Since material may be bent or 
slanted, the depth should be 0.1-0.2 mm deeper than the thickness of 
material for perfect cutting. 
This option value is disabled for input because the depth is 
automatically calculated by “Plate Thickness”, “Extra Cut Depth” option.  

Option 

Z pitch 

When cutting the engraving depth little by little, designate the depth. 
When cutting thick materials with a thin tool, this option is necessary. 

 

Plate thick 
Enter the measured material thickness. Cut depth and Z pitch value is 
automatically calculated by this value. 

Extra cut 
depth 

Material might usually be bent or slanted. Because of this, the cut depth 
should be 0.1-0.2 mm deeper than the thickness of the material for 
perfect cutting. This designates the extra depth for the perfect cutting. 

Z pitch count Z pitch value is automatically calculated by this value. 

Speed 

XY speed Designate a speed at which XY axis will move during the cutting. 

Z speed Designate a speed at which Z axis will move during the cutting. 

Move 

option 

Z clearance 

This designates the height to be applied for the clearance between the 
tool and the surface of material when moving to other engraving 
position. When moving to another engraving location, it is necessary to 
lift Z axis to prevent the tool from coming in contact with the material 
surface before moving. For this, designate the height to be applied at 
this time. 

 

Z Pitch 

Actual engraving depth 

Z Clearance 
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Z dwell time 

This designates no-load rotation time of end-mill and V-cutter after they 
reach the target depth and before move to X, Y axis point.  
It is possible to damage the tool as rotation speed reduces while 
engraving, So set up the Z-dwell time to recover the full rotation speed 
before engraving. 

✽Recommended time: 0.5 ~1 second. 

 

10. “Toolpath” is created. 

 

 
 

11. After create the toolpath, set the cutting option. Then click [Engraver] button. 
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12. Once “NC Output” window appears, specify how to measure the engraving material. And then, click “Start 
Engraving” button.  

 
 

Surface Height 

Measure material height only. 

 

Horizontal Slope 

Measure material’s horizontal slope. 

 

Vertical Slope 

Measure material’s vertical slope. 

 

Surface Slope 

Measure material’s top, bottom, left and right slope. 

 

Skip 
Do not measure its height. In this case, the previously measured height is 
used. If the material is not removed from the clamp during the previous 
engraving work, the measuring time can be saved with this option.  

Adjust 
Engraving 
Position 

Designate whether to re-adjust the engraving location. If this option is 
selected, the laser pointer will be turned on to allow the user to adjust the 
engraving location before engraving. If this option is not used, engraving will 
initiate immediately.  

Move to vise 
automatically 

Automatically moves to the flat or rotating vise according to the selected 
template.  
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13. Once the tool is moved to the center of the material and located, the engraving area can be verified and 
adjusted by using the direction key button. At this time, check the laser pointer while moving it for easier 
measurement and adjustment. 

 

Whenever the direction key is pressed, move the laser pointer to the left, top, 
right and bottom of the engraving area to show the area to be engraved. Check 
whether the area to be engraved is outside of the materials surface. If so, adjust 
the location by using the direction key.  

 

The laser pointer moves the area to be engraved to the left, top, right or bottom 
according to current location. If the current location of the laser pointer is left, 

then, press   key to move the area to the left. 

 
 

14. After the location of engraving is decided, press and hold  button until it beeps (more than 3 seconds) 
to start the engraving and close the engraver cover. 

  

Work area 
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Pen engraving process 

 
 

-Tailstock is purchased separately. 

 
1. Measure the width and diameter of the pen to be engraved. 

 
 
2. Fix the pen in the engraver by using a pen clamp.  

 
 

 
Though the pen jig may differ according to model types, instructions are almost the same for 
all types of engravers. Engraving direction is as shown below, So be sure of the direction after 
confirming the direction of the target object.  

 
 
3. Select pen template in the object property window. Enter the width and diameter of the pen, and click “OK” 
button. 

 
 

  

Diameter 

Width 
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4. Once the template appears, press [Text Input] on the toolbar. Click the work area with the mouse and 
enter text. 

  

5. After text is entered, press  [Selection] on the toolbar to enter object selection mode. After selecting 

entered text, adjust the size and font of the text.  Click  [Center in Page] button to place the object at the 
center of the work area. 

 
 

6. Once the design is completed, click  [Hatching Tool path].  

✽Click  on the right top without creating a Toolpath for immediate Marking. 
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7. Select engraving option and tool from the “Hatching Toolpath” window, and designate hatching gap and depth 
when necessary and click “Create Toolpath” button. 

 
 
8. “Toolpath” object is created. 

     
 

9. Click  button.  
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10. Once “NC Output” window appears, specify how to measure engraving material. And then, click “Start 
Engraving” button.  

 
 
11. Once the tool is moved to the center of the material and located, the engraving area can be verified and 
adjusted by using the direction key button. At this time, check the laser pointer while moving it for easier 
measurement and adjustment. 

 

Whenever the direction key is pressed, move the laser pointer to the left, top, 
right and bottom of the engraving area to show the area to be engraved. Check 
whether the area to be engraved is outside of the materials surface. If so, adjust 
the location by using the direction key.  

 

The laser pointer moves the area to be engraved to the left, top, right or bottom 
according to current location. If the current location of the laser pointer is left, 

then, press   key to move the area to the left. 

 
 

12. After the location of engraving is decided, press and hold  button until it beeps (more than 3 seconds) 
to start the engraving and close the engraver cover. 

 

  

Work area 
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Drilling 
 

What is Drilling?  
It drills a hole in a certain depth and diameter on materials by using endmill or V-cut tool. Depending on 
the tool thickness, the size of the hole becomes different. 
 
Be sure to lock the tension. If the head is not fixed, the drilling may not reach the designated 
depth. 
 

 
 
Select [Insert] menu to use [Drilling] on the menu below. 

 
 

◈ Add drilling object  
If “Add Drilling Position” is selected and the work area is clicked, a drilling object will be created. Drilling options of 
the created object such as drilling depth and speed can be changed on the object property window on the left of 
the screen.  
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The drilling object can be copied and used in several constant gaps by using Edit menu → Copy → Duplicate 
Horizontally or Vertically. 

  
 

 
 
Drag and move the drilling objects with the mouse to drill it into various shapes.  
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◈ Fill Inside Object with Drilling Position 
 
1. Create a shape to be filled with drilling objects.  

 
 
2. Select the shape and click Insert menu → Fill Inside Object with Drilling Position. 

 
 
Select a tool to be used on the “Drilling Object Auto Creation” window and adjust options such as depth, speed, 
gap and etc. 

 
 
The object to be drilled is automatically created inside of the selected object in a designated gap. 

 
 

1 
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◈ Layout Drilling Position along Line 
The object to be drilled along can be allocated along the outline of the selected object.  Select a line on which the 
drilled object is automatically allocated. Click [Insert] → [Layout Drilling Position Evenly on Line]. 

 
 
Select a tool to be used on the “Drilling Object Auto Creation” window and adjust options such as depth, speed, 
gap and etc. 

 
 
The drilled object is automatically created along the outline of the selected object in a designated gap. 

  

1 
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Engraving curved materials 
When a material to be engraved is curved, the engraving process may scratch the surface of the material. 
Entering the thickness of curved surface to be engraved to automatically set up the Z moving height can prevent 
the scratching of the surface. 
 

1. Create a toolpath and Click  button. 

 
 
2. Once “NC Output” window appears, click “Uneven” to show various kinds of the curved material. Select a 
shape that is the most similar to that of the material to be used and enter the thickness (thickness of the area to 
which the engraving is applied) of the material’s round part. 
 

   
 
 

 
 
 
 

 
 
  

Enter the thickness of the 

part to be engraved. 
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Layout of text in a circle 
 

Text can be laid out in a circle by using circular text object. 

 

 

  
 

 [Circular Text]  

Click  button to display “Circular Text” window. Designate direction and angle, enter the size and text, then 

click “OK” button. 
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 [Circular Text- Top/Bottom]  

      

 [Adjusting layout angle] 

Drag the first character [R] or last character [y] in the text to adjust the angle of the layout. 

 

          
 

 

 

 

 

Drag other characters with the mouse to adjust the distance to the center of the circle. 

                          
 

 

Drag with mouse to adjust 

the layout angle. 

Drag with mouse to adjust 
distance from the center of the 

circle. 
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Layout of text on a curve 

1. Click the  [Line/Curve] button. 

 

2. Click on a certain point with the mouse and designate a distance. Drag the mouse to make a curve appear. 

Press the right button on the mouse to create the curve. 

 

  
 

3. Select “No Line” on the “Line and Fill Shape” window on the object property window. 

 

               
 

4. Click  [Text Input] button, and move the mouse cursor to the curve line. The cursor shape will change as 

shown below. 

                 
 

5. In the state in which the cursor shape is chaged, click to enter the text input mode. 

 

  

[Mouse drag] 
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Text change 
The text contents in text objects can be easily changed by the [Text Change] feature. 

Import a saved design sample, file, or select text objects designed on the screen. Click  [Text change] button 

or right- click the mouse, and select [Text Change] on the menu. 

Or select [Menu] → [Text] → [Text change].  

 

 
 

Change contents in the “Text Change” window, and click “OK” button. The changed texts will be shown on the 

screen. 
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Template creation 
 

Template is an image corresponding to the materials to be engraved by 1:1 ratio. Load a template that is the most 

similar to the material to be engraved, and enter the text to be engraved. This allows you to create the location of 

marking and the size of text to be engraved more easily and conveniently. Circle, heart, square and diamond-

shaped templates are initially provided by the program and users can freely add more templates. The shape of a 

template can be designed by graphic program (Illustrator, Photoshop, CorelDraw and etc.) and loaded by SVG file 

format. Also scanned image file such as jpeg, bmp, png, etc. can be applied as template. 

 

[Creating template #1] 
1. Select [Menu] → [Template] → [Create Template from Image]. 

 

 
 

2. "Create Template from Image” window appears.  
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3. Select image files (jpeg, bmp, png and etc.) from the “Open” window, and click “Open” button. 

 
 

4. Input size of the template. Check “Save” to save the loaded image as a template for later use and enter a name 

for the template. Click “OK” button to load the image as a template.  If “Save” is checked, and the template name 

is given, the loaded image will be saved as a template in the template library simultaneously. 
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[Creating template #2] 

1. Press  [Image] button to open an image. 

 

     
 

2. Select [Menu] → [Template] → [Save Selected Object as Template].  

Type a name of the new template in “Input” window.  
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3. The saved template is added in the template library. 
 

 
 

The template saved in the “Save Selected Object as Template” menu is saved as designated size to the 

screen. When loading the template, check “Maintain Original Size”, then the template will be loaded with 

the original size designated when the template was saved. 
 

 
 

✽ Right-click in the template category window for more template related features. The template can be deleted 

by “Delete” on the menu that appears by right-click in template list window. 

  

[Mouse right button click] 
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Saving as design sample 
Edited contents can be saved as design sample for easier access to the design. 

 

[Saving as design sample #1] 
1. Edit contents and select the objects. 

 
 

2. Click File [Menu] → [Save as Design Sample] and select a folder or create new folder.  

Enter the name and click “Save” button to save it. 
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[Saving as design sample #2] 

 

1. Select objects, and click  [Design Sample] button. And select a folder to save the objects from design 

sample library window. 

 
 

2. Click [Save selected image as sample] or right-click the design sample image, and click “Save Selected 

as Design Sample” menu.  

 

 

 

   
  

[Mouse right button click] 
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3. Enter the name to be saved, and click “OK” button to save it in the design sample library. 

 

 
 

          
 
✽ Right-click in the design sample window for more related features. The design sample can be deleted by  

click  or “Delete” on the menu that appears by right-click in design sample window. 

 

 

  

[Mouse right button click] 
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Auto change of serial number 
 

Use this function when changing numbers by certain unit. 

 

1. Edit the font and size of text object with a number, and press “Alt+N” key on a keyboard, or select [Menu] → 

[Text] → [Serial Number] → [Advance Serial Number] to change the number automatically. 

 

 
 

 
 

 

            
 

 

2. Select [Menu] → [Text] → [Serial Number] → [Serial Number Option] and enter a unit from the “Serial Number 

Auto Advancing Option” to change the serial number by the designated unit automatically. 
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3. If the serial number is not regular, then select [Menu] → [Text] → [Serial Number] → [Load Serial Number]. 

Enter serial number in the “Lines to export” field or click “Load File” button to load it from a file (.txt or .csv file 

format).  

Once serial numbers are loaded, click “Export to object” button. The text on the selected text object is 

automatically changed, and the serial number is deleted from the list. The deleted numbers will be shown in the 

“Exported Lines”. 
 

 
 

 
Serial numbers can be loaded from a file separated by a comma (.csv) or text file (.txt).  

Each row of the file is recognized as one serial number, and the contents of each row separated by 

comma are shown in the next line. 
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Loading and editing image 
 

1. Loading an image 
This program provides a function to load various types of image files. Supported image file types are as follows. 
 

BMP Windows or OS/2’s bitmap graphic file 

GIF CompuServe graphic file 

JPG/JPEG JPEG bitmap graphic file 

PNG Portable Network Graphics bitmap graphic file 

PCX Z Soft PC paintbrush bitmap file 

TIF/TIFF Tagged Image File Format bitmap file 

WMF Windows meta file 
 

Image file can be loaded by following method. 

1. Select  [Image] on the toolbar or select [Menu] → [Insert] → [Image]. 

 
 

2. When “Open” window appears as the figure below, select the image to be loaded, and click “Open” button. 
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3. Drag the work area with the mouse to load the image by desired size. 

 
 

2. Converting and editing image 
 

Only single color image can be engraved. Since multiple color images cannot be engraved by machine, it should 

be converted to a single color (1 bit) image. 

 

[Converting to single color image] 

 
1. Select the image object you want to convert, and click “Convert” button in the image object window and select 

“Monochrome (1bit).” 

  
 

Or select the Transform menu → Bitmap → Mode → Monochrome (1bit). 

 
 

  

[Mouse drag] 
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2. “Color Image to Black & White” window appears as shown below. Adjust the slider to change it to the most 

suitable single color, and click “OK” button. 
 

 

 

[Editing image] 
Loaded image can be edited by “Paint” program in Windows.  

Select the image object to be edited, right-click it to select “Edit” or select [Menu] → [Transform] → [Bitmap] → 

[Edit].  

 
 

Click [OK] to run Windows Paint program. 

 
Then, Windows Paint program will show the image.  

After editing the image, press “Save” from the File menu of Paint, and close the program to apply the edit. 
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Import a file in SVG format 
Loading vector graphic files such as SVG file is also supported. 

The SVG file is created by various graphic programs such as Illustrator, CorelDraw etc. 

 

1. Select File menu → Save As from Illustrator program to save a file in SVG type. 

 
 

 

 

 

2. SVG option window appears. Press “OK” button to complete the save.  
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3. Click  button to load the SVG file. 

 
 

4. Or select [Menu] → [File] → [Import…] to import a file. 
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Calibration 
※ The machine is initially set up at the factory. Please contact reseller before changing the machine 

settings. 

※ Calibrate the machine by using tip(Carbide, Diamond). The machine cannot be calibrated by 

using endmill, cutter, etc. 

※ Calibrate the machine only when Engraver pressure lock is not fixed. The nose, tool, and material 

can be damaged if you calibrate the machine when the head is fixed. 
 

1. Touch Sensor (Tool Calibration) 
1. Fix a flat surfaced material on the clamp. 
2. Fix the tool short enough. 

3. Press  (Flat) on operation button to move the tool to the clamp. 

4. Press  button and go to the menu mode. 

5. Press button, and when 3.Calibration menu appears on the LCD window, then press and 

hold  button to run the menu. 

6. Select the “1.Touch Sensor” then press and hold  button to run the menu. 
 
7. The tool will be lowered down to the material and placed in the center of the clamp. 
 
8. Lower the tool manually by loosening the fixing bolt of the tool with a wrench, or raise the material with your 
hands to make the tool and materials come in contact as shown in the picture below. 
 

 
 

9. Press and hold  button until it beeps (more than 3 seconds) to confirm that the setting is saved, then the 
tool will measure the material’s height. 
 

2. Probe Calibration 
1. Fix a flat surfaced material on the clamp. 

2. Press the  button and go to the expert menu mode. 
 

3. Press button, and when 3.Calibration menu appears on the LCD window, then press and 

hold  button to run the menu. 
 

4. Select the “2.Probe” then press and hold button to run the menu. 
 
5. When appears on the LCD window as below, press [Start] button on the LCD window, then press [Z-/Z+] button 
to lower the tool to make it close to the materials, and release the tool by using a wrench until the tool touches the 
materials. Then tighten the tool. 

The tool comes in contact with on the material 
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6. Press and hold  button until it beeps (more than 2 seconds), then the probe will measure the material 
and then the machine will measure the tool before the settings are saved. 
 
7. Press [Check] button to start a test run. At this time, the tool draws four lines on the materials. If two lines out of 
four lines are seen on the material, then it is appropriate. If three lines are shown on the materials, , then press Z+ 

button to raise it by 0.05mm, and if one line is shown, then press Z axis Z- button to lower it by 0.05mm  

(※0.05mm per line .) 
 

 

       
 

8. Press and hold  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

 
3. Laser Pointer Calibration 
 
[Spindle] 
 
1. Fix a flat surfaced material on the clamp. 

2. Press  button to move the tool to the clamp. 

3. Press  button and when 3.Calibration menu appears on the LCD window, then press 

 button to run the menu. 

4. Select the “3.Pointer/Flat” then press  button to run the menu. 
 

5. The tool draws cross (＋) lines on the materials and the laser pointer is turned on. 

6. Move the laser pointer to the center of the cross by using the  direction key. Then press 

 button. 
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7. Laser pointer moves closer to the material to accurately calibrate the laser pointer’s origin. 

Move the laser pointer to the center of the cross by using the   direction key on the engraver, 

and press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 
 

[Rotation clamp] 
1. Turn the clamp knob on the left side of the clamp and pull the clamp and spacer block to take it out. 

               
2. Fix a ring on flat surface of the rotation clamp.  
(When set the laser pointer calibration, ring outer diameter Max.18mm(0.7in)/ Over 18mm(0.7in) are not 
available.) 

 

3. Press  button to move the tool to the clamp. 

4. Press  button and when 3.Calibration menu appears on the LCD window, then press 

 button to run the menu. 

5. Select the “4.Pointer/Rotary” then press  button to run the menu. 
 
6. The tool draws cross (+) on the materials, and the laser pointer is turned on. 
 

7. Use the  direction key to move the laser pointer to the center of the cross, and press 

button to save the settings. 

 
 
8. Laser pointer moves closer to the material to accurately calibrate the laser pointer’s origin. 

Move the laser pointer to the center of the cross by using the  direction key on engraver, and 

press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 
 

[L-Tool] 
1. Turn the clamp knob on the left side of the clamp and pull the clamp and spacer block to take it out. 

 
2. Fix a ring on flat surface of the rotation clamp. (Ring Ring outer diameter Max.18mm) 
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3. Press  button to move the tool to the clamp. 

4. Press  button and when 3.Calibration menu appears on the LCD window, then press 

 button to run the menu. 

5. Select the “5.Pointer/L-Tool” then press  button to run the menu. 
 

 
6. When message appears as below on the LCD window as shown below, pull the L-Tool down by L-Tool line 1. 

Then press button.  

 
 

7. The tool draws cross (＋) lines on the materials. 
 

8. When this message appears as below on the LCD window, pull up the L-Tool and press the button, then 
laser pointer is turned on. 

 

9. Move the laser pointer to the center of the cross by using the direction key, and press the 

 button to confirm that the setting is saved. 

 
 
10. Laser pointer moves closer to the material to accurately calibrate the laser pointer’s origin. 

Move the laser pointer to the center of the cross by using the direction key on the engraver, 

and press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 
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4. Saving Multi-performance Clamp Origin Position 
 

1. Press  button to convert to [Move mode-Flat]. 
 

2. When appears on the LCD window as below, press  [Laser pointer] button to turn on the laser pointer. 

 

               

3. Select the “CENTER” by using the   direction key. 
 

 
 

4. Press the  button to confirm that the setting is saved. 
- Short press button: Temporary save (message guide X) 
- Press and hold button for more than 3 seconds: permanently save  

          

               

5. Press the  button to save the setting.  
 

5. Saving New Clamp Origin Position 

1. Press  button to move the tool to the clamp. 

2. Press  button and when 2. Select Origin menu appears on the LCD window, then press 

 button to run the menu. 

3. When menu appears on the LCD window as shown below, select the “Clamp” by using the  button, 

and select the “Origin” by using the  buttons. 

            
 

4. Press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 
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6. Chuck Finger Origin point 
1. Set the chuck finger to the rotation clamp of the engraver. 

        
[Flat chuck finger]              [Round chuck finger] 

 

2. To enter the [Standby-Rotary] mode, press [Finger Mode] button. 

       

           
 

3. Press  button to convert to [Move mode-Rotary]. 

 When appears on the LCD window as below, press  [Laser pointer] button to turn on the laser pointer. 

 

               
 

4. Use the  direction key to match the laser pointer to the base point of each chuck finger as 
shown below. 

        
[Flat chuck finger]              [Round chuck finger] 

 

5. Press the  button to confirm, and press  button to change mode(Flat finger → Round finger → 

cylinder). After selecting the origin save mode, then press the  button to save the settings. 
 
- Short press button: Temporary save (message guide X) 
- Press and hold button for more than 3 seconds: permanently save  
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7. Rotation Clamp Origin point (Z axis) 
 

1. To enter the [Ring Inside] mode, press [Finger Mode] button. 

       

           
 
2. Set the sharp tool into the rotation chuck of the engraver as shown in the picture below. 

    
 

3. Press  button to convert to [Move mode-Rotary]. 
 

4. When appears on the LCD window as below, press  button to change the [Z-axis mode]. 

          

               
 

5. Use  buttons to align the end of the ring ring inner diameter engraving tool and tip of the sharp tool 
on the same horizontal line. If the distance between the tool and the sharp tool is too far, then bring them closer 

by using   button. 

 

6. Press the  button to confirm, And press the  button to save the setting 
- Short press button: Temporary save (message guide X) 
- Press and hold button for more than 3 seconds: permanently save  
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8. Camera calibration 

Bakelite plate 

(120x100x2t) 
 

 
1. Camera can be calibrated in the MagicEngrave program. 

   
 

2. Use the  button to adjust the red line on the clamp (screen) to center of the clamp, then click the 
[Next] button. 
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3. After fix the bakelite to the clamp, set the calibration area to 90 x 70mm and click the [Create Line] button. 

  
  

4. Press and hold the  button until it beeps (more than (more than 3 seconds) to start engraving a rectangle 
for calibration. 
 

5. Move the corner marks to the four corners of the calibration line with the mouse or keyboard and align them 
correctly. 

    
<[Real-time camera view] on program > 
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6. Confirm that the calibration results on the program screen are located above the + line (cross line) of the 
rectangle on bakelite with the red + line (cross line) as shown below, then click the [OK] button to complete the 
calibration. 

 
 


